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Living in the information age, we benefit tremendously from the availability and the abundance of 
information. Global communication, modern medicine, and computers are just few of the endless 
examples of information age products and services that significantly improve the quality of our lives.
 
Because information is valuable, the way you work is largely dictated by its constantly changing and 
abundant nature. Your ability to absorb, assimilate, and communicate information hence dictates the 
success of your work. Whether you are in school or you are a working professional, you must deal 
with a large amount of vital information in a timely and effective manner.

Did you know that exams, job training, business procedures, and sales presentations all share 
common traits? They do: the more you know, the better off you are. And the more you can remember
and integrate the information vital to your work, the better you become at solving problems. The 
purpose of DigiCard, then, is to help you excel and put you ahead.

Simply think of DigiCard as a free-form flash card program, designed with power in mind. DigiCard 
lets you create flash cards and assimilate and memorize your customized information in a variety of 
effective ways. And DigiCard lets you accomplish this via a smooth, friendly interface. This means 
that you can transform a large amount of information into your personal knowledge faster and better 
than ever before.

Whether you are memorizing a vocabulary list or mastering the national medical board, DigiCard 
makes learning a much less painful and even a fun and rewarding experience!



Students
If you are a student, DigiCard will become your best friend.
n DigiCard will help you decrease your study time, increase retention and boost your grades. One 

DigiCard user is able to consistently achieve high scores on her major college exams. This is 
quite a significant impovement considering she used to be a B student!

n Use DigiCard to memorize key facts and salient points for smooth and successful speeches and 
presentations.

Professionals
Here are examples of how DigiCard can benefit you professionally:
n Preparation for state and national board exams for brokers, insurance agents, engineers, 

doctors, lawyers, CPAs, and other professionals.
n Memorization of procedures and protocols.
n Knowledge of product information and facts.
n Improvement in speeches and presentations.
n Facilitation of on-the-job training.

Uses of DigiCard are only limited to your imagination!



DigiCard is an effective learning tool to help you save time and improve your everyday academic and
professional life. Here are six reasons why:

n DigiCard is interactive; you are now participating in the learning process rather than being just an
observer (i.e., reading books and listening to lectures).

n DigiCard presents your learning materials to you in six possible ways. You decide what method is
best for you and your particular subject.

n The key to learning is repetition. DIgiCard greatly facilitates and accelerates this process for you.
n The prerequisite to understanding is memorization. DigiCard not only helps you memorize your 

material, it encourages your mind to integrate the information. This occurs because the human 
mind has a great tendency to create a conceptual framework around related ideas.

n Even the act of making flash cards reinforce learning. The mental task of deciding whether to 
include or exclude information from a card and the act of typing serve as two different modalities 
to    complement your learning.

n DigiCard lets you use time efficiently; all of your learning and reviewing time can be used to 
master cards containing difficult or unfamiliar concepts when you discard those that you know 
well.



 See Also

While DigiCard is easy to use, the following sections are designed to make sure you get the most out
of DigiCard. We will begin with an overview that will get you acquainted with the basic components of
the program. Then, we will go through a simple exercise and make your first DigiCard file. The 
sample file "States and Capitals" is provided to demonstrate the various ways you can review your 
learning materials.

DigiCard consists of two modules, the Editor and Viewer. The Editor allows you to make up your 
flash cards. That is, it lets you enter the questions, answers, and keywords. You can edit and revise 
any information in your DigiCard file at any time using the Editor.

The Viewer presents to you the cards you have made using the Editor. The Viewer is flexible; you 
can instruct the Viewer to present your cards in ways that match your study style, the subject matter, 
or even your mood. For instance, the Viewer can show you your cards by three styles of presentation
(Sequential, Random, and KeyLink). Or you might decide to reverse the order of the usual question-
then-answer format to that of an answer-then-question format (a-la-Jeopardy). Together, you have 
six different presentation schemes, which are designed to significantly improve the way you 
memorize and integrate information. Time is spent efficiently while reviewing, because when you 
discard those cards that you know well, you are studying only unfamiliar concepts and saving 
valuable time. Since the whole process is interactive, studying no longer has to be boring!

In the next two sections are two tutorials to get you aquainted with Editor and Viewer functions. 
When you strike out on your own, remember that help is with you every step of the way. If there is an
object on the screen you have questions about, just point to it and look a the status box located at 
the right hand side of the tool bar for a brief description. If you are still stuck, just hit the F1 key.

Tutorial 1: A Simple Exercise
Tutorial 2: Sample File "States and Capitals"



See Also...
Presentation Style
Presentation Format



Presentation Style
Sequential
Random
KeyLink



Sequential Style of Presentation
n Cards are presented sequentially, from the first card to the last.
n This is the default presentation style.
n Tip: Use this style of presentation for initially reviewing your cards or for subject matters that are 

sequential in nature (i.e., preparing for oral presentations).



Random Style of Presentation
n Cards are presented to you randomly from a constantly shuffled deck.
n Tip: Randomly presented cards, over time, fosters associative learning. The random nature will 

provide new points-of-view and allow your mind to integrate related information much more 
quickly than the traditional method of study.



KeyLink Style of Presentation
n Although keywords are optional, some of your cards must contain one or more keywords in order

to take advantage of KeyLink presentation.
n In KeyLink, DigiCard surveys all of your cards and group your cards together according to 

keywords. DigiCard then randomly selects a group at a time for presentation. See tutorial 2 in 
this help file for a demonstration of the KeyLink feature.

n The frequency at which a group is selected for KeyLink presentation is proportional to the 
number of cards the group contains. Thus, you will see cards from a large group more often than
small groups.

n Tip: KeyLink is ideal for reviewing related concepts in groups. Viewing related cards in groups 
stimulates the formation of a mental framework and ensures that you are seeing every card in 
the proper context.



Presentation Format
Question First
Answer First



Question First Format
n The question comes before the answer.
n This is the default presentation format.



Answer First Format
n Exact reverse of the question first format - answer comes first, then question. Just like Jeopardy.
n Tip: Ideal for definitions and other short answers. The reversal is especially beneficial for 

reinforcing your knowledge of the subject matter at hand.



To make it easier to follow, select 'Print Topic' from the File menu for a printout.
This section will help you get started making your first DigiCard file and to acquaint you with the 

Viewer. Simply follow the steps below:

1 Using your learning material, let us begin by making a file of several cards. From the File menu, 
select 'New.' In the Editor, click once on the window labeled 'Question.' You will now see the 
blinking cursor in the question window. Now type in your first question.

2 After you enter the question, you can either hit the tab key or click once on the window labeled 
'Answer.' The blinking cursor is now in the answer window. Now answer the question you have 
posed. Take care to phrase your answer as concisely as possible, as this will increase the 
efficiency of learning and increase retention.

3 Now you are ready to save the card. Using the mouse pointer, click on the 'Save' button. When 
the contents of the card is saved to disk, the button will change to 'New Card.' Click on this 
button.

4  At this time, note that the toolbar will inform you that you are on "Card 2 of 2." Repeat steps 1 
through 4 several more times. Save the file by selecting 'Save As' under the File menu and 
provide a name for your DigiCard file.

5 When you have about five cards, we are ready for a demonstration of Viewer features. Switch to 
the Viewer module by clicking on the snow flake icon (between the delete and left arrow buttons).

6 In the Viewer, you will notice right below the tool bar the word "Sequential." This indicates that 
the sequential presentation style is currently active. Use sequential presentation for reviewing 
your newly created cards, making sure the questions and answers are the way you like them to 
be.

7 Begin your review. To see the answer, push the 'Show Answer' button. You will notice that the 
label changes to 'Next'. Push this button when you are ready to move on.

8 Repeat this process for all of your cards. At any time if you want to edit your card contents, 
double click on the Viewer window.

9 Now we will try out the random style of presentation. Push the 'Options' button and select 
'Random'. Press OK.

10 Notice that card presentation is totally randomized now. Randomly presented cards, over time, 
fosters associative learning. Whenever you encounter a question, try hard to state the answer 
before you go on to the next card.

11 As you go through your cards a few cycles, you will notice that information will begin to stick. 
Before you disable a card containing information that you think you know well, make sure you 
see the card several more times to solidly reinforce the learning. To disable a card, click the 
'Discard' button.

12 When all cards are disabled, you will be notified of this and DigiCard will automatically enable all 
cards. Before we end this tutorial, try the reverse question-answer format. Push the 'Options' 
button and select 'Answer First.' Now studying can be just as challenging as playing Jeopardy!

Congratulations! You have completed your first DIgiCard tutorial. As you complete your file, note that 
you can specify the start up configuration by setting and saving your preferred options (i.e., Random 
and Answer First). You can even set the start up module for this file to Viewer, so that the next time 
the file is loaded, you will be ready for review (go to the Options menu and set the start up module to 
Viewer).



To make it easier to follow, select 'Print Topic' from the File menu for a printout.
If you are new to DigiCard, be sure to go through tutorial 1 before beginning this one. In this tutorial, 
we are going to explore the KeyLink feature. In KeyLink, DigiCard surveys all of your cards and 
group your cards together according to keywords. KeyLink is ideal for reviewing related concepts in 
groups for maintaining the proper context.
The sample file "States and Capitals" illustrates the use of keywords in KeyLink presentation. Simply 
follow the steps below:

1 In this sample file, states are categorized by time zones. For instance, all of the cards 
representing states in the Eastern standard time zone have the keyword "Eastern" and likewise 
for the other states. From the File menu, open the file 'SAMPLE.CRD' in the directory containing 
the DigiCard program.

2 After the file loads, you will notice that the Viewer module is active for KeyLink presentation. As 
you place the arrow on the 'Show Answer' button, also note that the status window is displaying 
the word "KEY" followed by a time zone. This indicates the active keyword. In this case, 
keywords are time zones of the United States.

3 As you browse through the cards, DigiCard will present every state/capital located in the 
displayed time zone. After the last state/capital of the time zone is presented, DigiCard will 
randomly select another group of states with their capitals by time zone. Try this for yourself.

4 The way gouping cards together by keywords is accomplished is really very simple. Switch over 
to the Editor and go to card # 1. There are 51 cards total and the states are in alphabetical order.
Navigate through the deck by using the next card button. Notice that with a few exceptions, every
card contains only one keyword. See if you can spot the the states that reside in two time zones.

5 Switch back to the Viewer. Review the cards and notice that those states that are in two time 
zones are grouped in two separate categories.

6 If you prefer, you can keep the active keyword from being displayed by selecting 'Hide Keyword' 
from Viewer options.

As you can see, you can easily add keywords to your cards and take advantage of KeyLink 
presentation. Viewing related cards in groups is advantageous because it stimulates the formation of 
a mental framework and ensures that you are seeing every card in the proper context.



The following sections will explain to you the purpose of the various visual elements in DigiCard. 
Choose a section below and click on an object you need help with:

Menu and Tool Bar Interface
Editor Interface
Viewer Interface



Click an object you need help on...



Menu and Tool Bar help

Click an object you need help on...



Menu and Tool Bar help

Click an object you need help on...



The author is dedicated to the success of DigiCard users. For product support and/or suggestions on
how DigiCard can be improved, you may contact the author, Rob Chen, by any of the following ways:

n CompuServe ID: 73542,1232
n Internet Address: rchen@orion.oac.uci.edu
n BBS: Chips+ Connection (9 nodes)

1-714-556-3207
1-714-556-3208
1-714-760-3265

n US Mail: 6014 Verano Place
Irvine, CA    92715-3159

About the Author



About the Author

Hi, my name is Rob Chen and I am currently attending graduate school at University of California, 
Irvine. I aspire one day to help mentally retarded children by way of medical care and research. I am 
now in my second year of study.

DigiCard is initially the product of interest in helping my classmates and myself fufill a need in having 
an effective learning tool. Because of the success of DigiCard, I was encouraged to enhance and 
release the program to the general public. DigiCard is charityware because I firmly believe that there 
are many worthwhile causes that are in need of support. DigiCard thus fufills both my desire to help 
needy people and environmental concerns and to create a good program that helps people study 
and achieve their goals.

I appreciate any suggestions concerning this program. Please contact me and let me know of your 
experience.



The following is a list of national, non-profit charities that you can benefit by your registration fee.
If you would like to contribute to your local chapter of the following organizations or another non-profit
organization, please include, as a part of your registration, the name and address of the 
establishment so your contribution can be properly forwarded.
Even if you decide not to register this software, please make a difference in the world by supporting a
good cause!

    American Cancer Society

    American Diabetes Association

    American Heart Association

    American Lung Association

    American Red Cross

    National Council on Alcoholism and Drug Dependence

    National Multiple Sclerosis Society

    National Public Radio

    Nature Conservancy

    Public Brocasting System

    Salvation Army

    Sierra Club

    Surfrider Foundation

    United Cerebral Palsy Association

    United Negro College Fund

    World Wildlife Fund

    YMCA

    YWCA

Note: If you would like to see a particular charitable institution listed on this form, please send your suggestion to the author.





American Cancer Society

Enhances the quality of life for cancer patients by providing direct services, research, advocacy and 
prevention and early detection information.



American Diabetes Association

Enhances the quality of life of people with diabetes through education, support programs and 
research to cure and prevent diabetes.



American Heart Association

Dedicated to reducing disability and death from cardiovascular diseases and stroke.



American Lung Association

Dedicated to the prevention and control of lung diseases through education, community service 
programs and research.



American Red Cross

Provides emergency disaster relief, disaster preparedness training and planning, emergency 
communications for military personnel, financial assistance to military personnel, health and safety 
education, HIV/AIDS education, youth programs, volunteer services.



National Council on Alcoholism and Drug Dependence

Focuses on the disease of alcoholism, drug abuse and related problems through prevention, 
education and direct service programs.



National Multiple Sclerosis Society

Provides information, referral and support services to MS individuals and their families.



The Salvation Army

A religious and charitable organization committed to providing services for low income and homeless 
individuals and families, youth, and drug and alcohol rehabilitation without discrimination.



United Cerebral Palsy Association

Provides services to persons with cerebral palsy and similar disabilities: early intervention/therapy, 
support groups, life skill training, supported employment.



YMCA

Provides programs which improve spiritual, mental and physical welfare. Provides licensed day care.



YWCA

Child care, school for homeless children, youth employment service, fair housing program, dispute 
resolution, teen activities, after school program.



When you register DigiCard, you receive many benefits. These include:

n Support of a needy charity of your choice.
n License to use all future releases of DigiCard.
n Removal of the start-up introductory window.
n Copy of fhe latest registered version of DigiCard promptly mailed to your address.
n "Strategies for Success," a companion guide to DigiCard which is loaded with helpful tips to 

boost your academic and professional performance.
n One year free CompuServe / Internet e-mail / BBS / US Mail support (your choice).

Registration fee is only US $20. Please note that all net profits or 40% of your registration fee (which 
ever is greater) goes directly to support your favorite charitable cause!

      Click Here to Register!



You have a choice to either register DigiCard through CompuServe or by US mail. Simply click on a 
choice below:

      Registration via CompuServe

      Registration via US Mail



n To register through CompuServe, GO SWREG and select registration ID # 2211.
n The registration fee of $20 per copy will be billed to your account.
n The latest registered version of DigiCard will be mailed the next business day.
n Please contact the author regarding which charity you'd like to benefit through your registration.

How to Contact the Author



To print the following form, select 'Print Topic' from the File menu.

Mail-In Form

n Please register my copy of DigiCard. I am sending a check or money order for the amount of US 
$20 (per copy).

Name:_______________________________________________________

Occupation:__________________________________________________

Company:____________________________________________________

Address:_____________________________________________________

City:________________________________________________________

State:_______________ Zip:______________ Country:_______________

Telephone # _________________    (optional)        Number of Copies: ______

n Please benefit the following charity through my registration:

____________________________________________________________
                        If you would like to contribute to your local chapter of the listed charities or another non-profit
                        charitable institution, please provide the name and address.

n Send me disk format: _____ 3.5", 720k _____ 5.25", 1.2 meg 
 (check one) _____ 3.5", 1.44meg

n Comments / Suggestions:

____________________________________________________________

____________________________________________________________

____________________________________________________________

Please send completed form and registration fee (payable to 'Rob Chen') to:

ROB CHEN
6014 VERANO PLACE
IRVINE, CA    92715-3159



Evaluation
Thank you for using DigiCard. Please note that you may use DigiCard for a period not to exceed 45 
days for the purpose of evaluation. After this period, the author asks that you either register or 
discontinue the use of DigiCard. Registration of a single copy of DigiCard entitles the registrant the 
right to run it on a single computer.

Although the author makes his every best effort to ensure that DigiCard performs optimally and error-
free prior to releasing the software to the general public, users should read carefully and understand 
the disclaimer below before using DigiCard.

Disclaimer of Warranty
THIS SOFTWARE AND ON-LINE DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    BECAUSE OF THE VARIOUS HARDWARE AND 
SOFTWARE ENVIRONMENTS INTO WHICH THIS PROGRAM MAY BE PUT, NO WARRANTY OF 
FITNESS FOR    A PARTICULAR PURPOSE IS OFFERED.    GOOD DATA PROCESSING 
PROCEDURE DICTATES THAT ANY PROGRAM BE THOROUGHLY TESTED WITH NON-
CRITICAL DATA BEFORE RELYING ON IT.    THE USER MUST ASSUME THE ENTIRE RISK OF 
USING THE PROGRAM.    ANY LIABILITY OF THE AUTHOR WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE. USAGE OF THIS SOFTWARE 
CONSTITUTES AS ACCEPTANCE OF THE TERMS OF WARRANTY.



The following are files packed into the file 'DCARD20.ZIP' for distribution. If any of the following files 
are missing, please contact the author for replacement.

n README.TXT Read this file first.
n FILE_ID.DIZ BBS description.
n VENDOR.TXT For shareware distributors and

Sysops of on-line services.
n DIGICARD.EX_ DigiCard executable program and

DIGICARD.HL_ On-line help file.
n SAMPLE.CR_ Sample file "States and Capitals" and 

SAMPLE.CF_ Sample file configuration.
n SETUP.EXE DigiCard 2.0 setup files.

SETUP.LST Run SETUP.EXE to install DigiCard.
SETUP1.EX_
SETUPKIT.DL_

n CMDIALOG.VB_ DigiCard system files.
COMMDLG.DL_ *All files must be present for DigiCard to run.
DDEML.DL_
INICON2.VB_
MSAES110.DL_
MSAJT110.DL_
SPIN.VB_
THREED.VB_
VBDB300.DL_
VBRUN300.DL_
VER.DL_



The system configuration required to run DigiCard 2.0 is:

n 4 megabytes or more of RAM.
n 2 megabytes or more of disk space.
n VGA graphics and above.
n Windows 3.1 / Windows NT    / OS2 2.1 and above.



Version 2.0    (3-15-94)

n Implemented Microsoft Access 1.1 engine for data storage and handling. All DigiCard files are 
convertable to other database file types supported by Access (i.e., dBase, Fox Pro, etc.).

n Added two keyword fields per card.
n Added function for rapid search based on keywords.
n Enhanced the presentation module by adding KeyLink presentation.
n Simplified learning for novice users by adding context-sensitive help. This was done both in the 

form of status-line description of buttons and Windows help file when activated using the F1 key.
n Added the ability for the user to specify the default module upon start-up.
n Implemented a configuration file containing discard information and Viewer options unique to 

each DigiCard file.



Answer Window
n Contains an answer or response to the posed question.
n Text can be up to 32,000 characters in length.
n To insert a Tab:    [CTRL][ALT] & [TAB]
n Tip: make the answer as direct and concise as possible, as this will enhance learning and 

retention.



Auto-Discard
n Click once to check, again to uncheck.
n Auto-discard allows you to see each card once per round of presentation when you are using 

Random or KeyLink.
n All cards are automatically enabled when all cards have been discarded, at which time the cycle 

can start again.
n Tip: This is especially useful for the beginning of a study session or before an exam, when you 

may want to see every card several times in a short time frame.



Cancel
Disregard all changes and exit.



Card Number Indicator
n This indicates the current card number and the total number of cards in your DigiCard file.
n Click once to jump to another card.



Clear All Scripts
Checking this box will clear all five Editor scripts.



Control Box
To exit DigiCard, click on this twice.



If you have already invested time and energy into building flash cards for another program, 
converting the files to DigiCard format may be a relatively painless process. If your flash cards 
are saved to ASCII text files, just follow the simple steps outlined below:

1 From the File menu, select 'Import Text'.
2 Open your flash card file. TextPad will be activated automatically and you will see your file 

contained within.
3 From the Options menu, select 'Drag and Drop Editing' (if it is not already checked).
4 Highlight the question you want to incorporate into DigiCard. Then simply drag the question and 

drop it into the question window.
5 The process for the answer is the same. When you are done with the card, press the 'Save' and 

then the 'New Card' buttons.
6 Repeat steps 4 and 5 for other question-answer pairs.

Please contact the author if you would like to see a converter for your popular flash card program 
with the next release of DigiCard.



Copy
n Copies highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other applications.



Cut
n Cuts out highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other applications.



Delete
n Deletes current card from file.
n WARNING: Once your card is deleted from the file, it cannot be recovered. Take care in 

confirming deletes.



Discard
n Disables the current card.
n Clicking on this button temporarily inactivates the current card and keeps it from being displayed 

in Viewer presentations (note: this is not the same as delete).
n You can enable inactivated cards by either toggling the light bulb on (the card in question must 

be current) or by selecting the "Enable all cards" check box under Viewer Options.
n Tip: Your study time can be used most efficiently when you discard those that you have already 

mastered. This allows you to use all of your time learning new information.



Edit Menu
Cut, copy, and paste functions in DigiCard just like in other Windows applications. For instance, you 
may paste information from a word processor document into the DigiCard Editor and vice versa.

Cut
n Cuts out highlighted Editor text to the Windows clipboard.
n Shortcut:    [CTRL] [X] or [SHIFT] [DELETE]

Copy
n Copies highlighted Editor text to the Windows clipboard.
n Shortcut:    [CTRL] [C]

Paste
n Pastes Windows clipboard text to the Editor.
n Shortcut:    [CTRL] [V] or [SHIFT] [INSERT]



Click an object you need help on...



Enable All Cards
n Check this box off when you want to enable all of your cards for Viewer presentation.
n This option is available when one or more cards are inactivated.
n Tip: You may enable or disable individual cards by turning the light bulb on or off, respectively. 

The light bulb is located on the toolbar, and the easiest way to do this is to to navigate through 
your deck of cards using the the Editor.



File Menu
DigiCard file structure is based on the Microsoft Access 1.1 database engine. Using Access, 
DigiCard data can be manipulated and translated to other database formats such as dBase.

New
n Exit current file and create an untitled new file.

Open
n Open file. By default, DigiCard files have the .CRD extension.

Save As...
n Save your current DigiCard file under a new filename.

Import Text
n Open a text file into TextPad.
n Text file must be under 32k and devoid of hard page breaks.

Exit
n Exit DigiCard.



File Name
Indicates the name of the current DigiCard file.



Go To...
n Navigates the database of cards contained in the opened DigiCard file.
n Type in number directly or use the spin control to select a card.



You are currently in DigiCard help.
Press F1 for help on Windows Help.



Hide Keyword
n Click once to check, again to uncheck.
n By default, the active keyword is automatically displayed in the status window during KeyLink 

presentation.
n Hide keyword will prevent the active keyword from being displayed.
n This option is available when using KeyLink.



Keyword
n Keywords are necessary if you want to take advantage of KeyLink style of presentation. You can 

also search through the file for particular cards by using the search function in the Editor.
n You may enter one or two keywords per card.
n Tip: A keyword should be a word that captures the essence of the card containing it.



Discard Status
n Light on: current card is active for Viewer presentation.
n Light off: current card is inactive.
n You can toggle the discard status of the current card by turning the light bulb on or off.



Maximize
Expands the main DigiCard form to fill the screen.



Minimize
Reduces the active module to an icon.



Modules Menu
Editor
Switch to the Editor.

Viewer
Switch to the Viewer.



New DigiCard File
Exits current DigiCard file and creates an untitled new file.



Next Card
n Sequentially forward navigates the deck of cards.
n Any changes made to the current card are saved automatically.



OK
Executes all changes and exit.



Open DigiCard File
By default, DigiCard files have the .CRD extension.



Options Menu

Viewer Options
Presentation Style
Presentation Format
Auto-Discard
Hide Keyword

System Options
            Startup Module
n Selection of either Editor or Viewer will enable that module to start-up automatically when 

opening a DigiCard file.
n This information is saved to the configuration file.

            Drag and Drop Editing
n Checking this option will allow drag and drop copying of highlighted text from one Editor window 

and pasting it to another.
n Recommended for copying imported text to the Editor.

            Monochrome Display
n Check this option if you have a monochrome display.

Save Options
Saves all options. Viewer options are saved to .CFG file and DigiCard system options are saved to 
DIGICARD.INI.



Paste
n Pastes Windows clipboard text to the Editor.
n Clipboard contents may be from DigiCard or other applications.



Percent Enabled
n Displays the percentage of cards that are currently active for Viewer presentation.
n Ranges from 100% (all cards enabled) to 0% (all cards disabled).



Previous Card
n Sequentially backward navigate the deck of cards.
n Any changes made to the current card are saved automatically.



Question Window
n Contains a question or statement that will be elaborated upon in the Answer Box.
n Text can be up to 32,000 charaters long.
n To insert a Tab:    [CTRL][ALT] & [TAB]
n Tip: make the question as direct and concise as possible. The desired effect is to have your 

question automatically trigger the answer in your mind.



Repeat
Redisplay the question.



Save
n If new editing has occurred, the save button appears.
n Click on the button to save changes and to update the Viewer.

New Card
n Adds a new blank card to the deck.
n The new card will be added to the end of the deck.



Save As...
n Save your current DigiCard file under a new filename.
n By default, DigiCard files have a .CRD extension.



Save Options
n Checking this box off will allow all Viewer options to be saved to disk.
n Viewer options for a particular DigiCard file are unique to that file. The next time you load a 

DigiCard file, all the saved settings will be retained.
n The options configuration file has the same name as the corresponding DigiCard file with a .CFG

extension.



Apply Script
n Scripts can be applied only if you are currently in an Editor window.
n A script can be applied to the active Editor window by either clicking on the appropriate 

numbered button or by hitting [SHIFT] and the corresponding function key (F1-F5).



Script Window
n This time-saving feature is designed to save you from repetitive typing in the Editor.
n A script contains commonly used words, phrases, sententences, etc. that you use to formulate 

your questions, answers, and keywords. For instance, you may preface many questions with the 
phrase "What is the significance of..." Having this phrase as a script allows you to apply it very 
quickly and thus save time.

n To apply a script, first locate your cursor at the insertion point or highlight the text you want to 
replace. Then, select the 'Scripts' item on the menu and push the corresponding button.

n Shortcut: Locate your cursor as above and press [SHIFT] and the function key that corresponds 
to your script (F1 to F5).



Scroll Bar
Scrolls text upward or downward.



Search
n Finds card(s) based on keyword.
n Editor searches through Key 1 field first, then Key 2.



Show Answer / Next
n If a question is on display in the Viewer window, clicking on this button will reveal the answer.
n If an answer is on display, clicking on this button will advance to the next card. The card you get 

next will depend on the style of presentation (sequential, random, or KeyLink).



Status Window
n When you have questions about screen objects, point to the object and the status window will 

display a short description.
n Under KeyLink presentation, the status window will display the current active keyword.
n Tip: Click to toggle help description on and off.



Switch to Editor Module
Activates the Editor Module.



Switch to Viewer Module
Activates the Viewer Module.



TextPad
n Click to activate TextPad. Click again to deactivate.
n TextPad is automatically activated when a text file is imported into DigiCard.
n Use the TextPad to copy text directly into the Editor when making DigiCard files.
n Tip: Use drag and drop editing to save time. To turn it on, check 'Drag and Drop Editing' on the 

Options menu.



Click an object you need help on...



Viewer Window
n Shows questions in red, answers in blue.
n Double-clicking the Viewer window activates the Editor and allows editing of the current card.






